Preface

This documentation may not be copied, translated or converted to a machine-readable form, whether in whole or in part, without prior permission.

GEUTEBRÜCK GmbH cannot guarantee the correctness of any information provided in this documentation, nor for the software or the information it contains. Any suggested guarantee, assurance of marketable quality or suitability for a specific purpose of the documentation, the software or other information is hereby explicitly rejected.

Under no circumstances is GEUTEBRÜCK GmbH liable for direct or indirect subsequent damage or for special subsequent damage resulting from or in association with this documentation, regardless of whether this arises as a result of illegitimate action, of a contract, or for other reasons in association with this documentation, the software or of the information contained or used within it.

The software described in it is subject to the conditions of a special licence contract.

© 2015 by GEUTEBRÜCK  All rights reserved.

Please note that the illustrations in this documentation will not necessarily match those of your software version.

GEUTEBRÜCK GmbH retains the right to change this documentation or the information contained within it at any time without warning.

This documentation is a quick guide.

Detailed information about all features of the G-Core management software you can find in the online help G-Help.
## Contents

**Preface** ...................................................................................................... 1

**Quick Guide G-Core** .................................................................................. 3
  The management software G-Core ................................................................. 3
  The G-Set Wizards .......................................................................................... 7
    Connection Wizard ....................................................................................... 7
    Media Channel Wizard ............................................................................... 8
    Event/Alarm Wizard .................................................................................... 9

**Connecting an IP Camera in G-Set** ..................................................... 10

**Quick Guide G-View** ............................................................................. 15
  Introduction .................................................................................................... 15
  G-View - Description of the User Interface .................................................... 16
  Profile Manager ............................................................................................. 17
  Seeing and Controlling Images ...................................................................... 18
    Linking viewers to media channels (Cameras) .............................................. 18
    Select views and scenes ............................................................................. 19
    Controlling the image of a media channel .................................................... 19
    Zoom ......................................................................................................... 20
    Working with the time line ........................................................................ 21
  The Toolbar .................................................................................................. 22
  The Menus .................................................................................................... 23

**Searching and Filters** .......................................................................... 25
  Simple Search ............................................................................................... 25
  Advanced Search .......................................................................................... 26
  MotionSearch MOS ..................................................................................... 27
    Using MOS in the active viewer .................................................................. 27
    Using Background search .......................................................................... 28

**Export / Backup** .................................................................................. 30
  Exporting Pictures ........................................................................................ 30
    Printing an image ........................................................................................ 33
  Backup .......................................................................................................... 35
    Select region to be backed up ..................................................................... 35
    Saving the Backup ..................................................................................... 35
  Backup on DVD ............................................................................................. 39
  USB Memorystick ......................................................................................... 41

**Lists** ...................................................................................................... 42
  Eventlist ....................................................................................................... 42
    Filter events .............................................................................................. 43
    Data filter .................................................................................................. 44
    Advanced ................................................................................................. 44
  Alarm list ..................................................................................................... 45
  Cut list ......................................................................................................... 46
    The Cut list dialog user interface .............................................................. 47
    Working with the Cut list .......................................................................... 49
  Import and replay ........................................................................................ 51
  Export options ............................................................................................. 52
Quick Guide G-Core

This document describes:

- The parts of G-Core (G-Set, G-View and G-Help).
- The G-Set Wizards.
- The adding of IP-cameras in G-Set (with the G-Set wizards)

and how to proceed in G-View:

- Linking viewers to media channels/cameras.
- Specify a view or load a scene.
- Controlling the image of a media channel/camera.
- Working with the timeline.
- Search and filter pictures.
- Backup, export and printing of pictures.

The management software G-Core

After the G-Scope has been started and successfully integrated into a network, you can work with the device.

G-Core is the management software of the G-Scope. It uses the following applications which can be opened using the start bar or from the desktop using a double click:
**G-Set** is the G-Scope setup client.

In this Windows interface, you set the recording parameters, modify and assign passwords and access rights and add additional users for the system.

*The surface of G-Set after opening the program.*

There are three integrated wizards, which help you to set up your system:

- **Connection Wizard** 1
  Here you create, manage and verify connections to servers (Password, Ping, Connection).

- **Media Channel Wizard** 2
  You can see, report and manage all available cameras on the network.

- **Event / Alarm Wizard** 3
  Events and alarms are created and managed here.

G-Set can be started on the client side or directly on the server.
If you have opened G-Set on a workstation computer, in the program you must create and save a corresponding connection on the server.
In G-Set, you will perform, among others, the following tasks to set up the system:

- Register all IP cameras that are integrated in the network with your G-Scope.
- Set up the media channels. For each media channel the quality profile is determined for permanent recording and live streaming.
- Add the required I/O contacts, so that you can include the signals from the control inputs and outputs and the external switching devices for event configuration.

**G-View** is the G-Scope playback client. This Windows interface creates a uniform user interface for all system components and supports all functions of picture playback, from the reaction to alarm events to support of recorded picture sequences.

*The G-View user interface after opening the program.*

- As in the case of G-Setup, the **menu and toolbars** are at the top ①.
- The selection area where settings can be made are at the left-hand edge ②.
- The greatest part of the area is owned by the **Viewers**. They can be arranged over the area in various ways ③.
- Beneath the Viewer area There are the toolbars for:

  Recorder control, Alarm list and Telecontrol [Remote control] ④.
Using the online documentation
All necessary functions for set up and configuration of the system are described in the online help G-Help. Here you can find the details about the operating components G-Set and G-View.

You open the integrated online help using the Help menu in the menu bar of the open programs G-Set or G-View or with double click on the desktop icon.

On the GEUTEBRÜCK Homepage: www.geutebrueck.com you can find always the newest version of the Online Help.
The G-Set Wizards

Connection Wizard

The Connection Wizard is divided into 5 areas:

1. **Edit toolbar**
   Here you will find all the commands for editing of connections.

2. **List of configured servers**
   All configured servers are listed in this list.

3. **Connection data and options**
   Settings for the server selected in 2.

4. **Descriptions, encryption and connection tests**

5. **Server search**
   Search for servers in the network.
After opening the Media Channel Wizard, you will see 6 areas:

1. **The command bar**
   The command bar contains buttons for basic editing.

2. **The steps for the configuration of the media channels**
   The wizard guides you through the configuration in three steps: Setting up the cameras, configuring the media channels, checking the overview of the settings.

3. **A list of available cameras on the network**
   List of detected network cameras and the ability to add cameras manually.

4. **A dialog for general information**
   Settings for channel name, global number and channel-group assignment.

5. **A dialog for camera settings**
   Here you set the connection information to the camera.

6. **A preview image**
   Displays a preview image of the selected camera.
Event/Alarm Wizard

After starting the Event/Alarm wizard, you will see three areas:

1. **The steps for the configuration**
   The wizard guides you through the configuration in four steps: Event settings, action settings, recording and alarm settings. The fifth step shows an overview of the settings.

2. **Dialogs**
   This is where you will define your settings.

3. **Toolbar**
   Buttons for important commands to control the wizard and save the settings.
Connecting an IP Camera in G-Set

NOTE: For correct installation of IP cameras one **Option G-Core/CamConnect** must be available for each camera. Available options are shown in G-Set at **General settings - Options**.

Required options can be ordered using **General settings - Options** in G-Set. After clicking on **Options**, the options dialog opens with the first tab, which shows an overview of the available options.

The dialog shows the four tabs **Options, Dongles, Request new options** and **Failed requests**.

**Request new options**

New options can be requested using this dialog. When you click the dongle that will be assigned the new options, an URL appears in the field **Follow this link to purchase new options**. Right clicking this URL opens a menu in which the URL can be copied, saved or opened in the default browser.

After passing the URL to a browser, follow the instructions on the GEUTEBRÜCK website.
Adding IP Cameras

Please double click at desktop on the G-Set icon to open the G-Set configuration menu.

**Step 1: Connection to a server**

To connect G-Core with a (local or remote) server,

- Double-click on a connection available under Connections in the selection menu or
- In the Connection wizard dialog select a server from the list and click on the icon.
- By clicking Connection wizard, you can also configure new server connections.

**Step 2: Activation and configuration of Media channels.**

Left mouse click at Media channel wizard and click on tab Cameras opens the following window:

The Media Channel Wizard automatically searches for existing network cameras and displays them in the first column.

Cameras for which access rights (software options) are available are also displayed with a small camera image.
Now you can select the desired camera by clicking the tick box (changes to green) and edit the general information and the camera-specific data.

**NOTE:** If you want to control a PTZ camera, the tick box **PTZ** in the menu **Channel Settings** must be activated.

Left click on the tab **Media channels** opens the configuration window. At left column (camera tree) please choose the desired camera.

In the camera menus you can make the desired settings for **Permanent Recording** and **Live Stream**. Both are activated by default.
PERMANENT RECORDING

Permanent recording requires a few settings:

<table>
<thead>
<tr>
<th>FPS</th>
<th>Recording rate in FPS (frames per second)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval (ms)</td>
<td>Interval: A frame every X ms</td>
</tr>
<tr>
<td>Video profile</td>
<td>Selection of a preset profile (see table below)</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution of the image in pixels</td>
</tr>
</tbody>
</table>

**ADVICE:** Permanent recording is enabled by default. However, please note that you will only be able to find the recorded images if you have created a database. Without a database, the images from permanent recording will be deleted.

A standard database is created as factory default, which is pre-configured for recording.

You must create a database if you want permanent recording in addition to live streaming:

- Click Database on the General settings menu.
- A list of all the installed hard disks appears if you click Database volumes. Mark the drive on which you want to set up a database using the right mouse button.
- Enter the desired size on the settings menu. Confirm your input.
- After this you can set the ring buffer.

Detailed information about creating a database you can find in the online help G-Help.

LIVE STREAMING

*Live streaming* is enabled by default, but it requires a few additional settings to be made:

<table>
<thead>
<tr>
<th>FPS</th>
<th>Recording rate in FPS (frames per second)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval (ms)</td>
<td>Interval: A frame every X ms</td>
</tr>
<tr>
<td>Video profile</td>
<td>Selection of a profile</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution of the image in pixels</td>
</tr>
</tbody>
</table>
Step 3: Summary (check settings, confirm and transfer settings to the server).

Mouse click on tab Summary provides you with an overview of all the settings that have been defined for your cameras.

Please confirm your settings by clicking the button Save & Finish.

**IMPORTANT:** For settings to take effect, they must be sent to the server by clicking the icon 🔄.

You can find the transfer button 🔄 on the command bar of G-Set.

Finally you can check whether the camera is present in the network and the media channels are configured correctly.
Quick Guide G-View

Introduction

G-View is the G-Scope's playback client. This Windows interface creates a uniform user interface for all system components and supports all functions of picture playback, from the reaction to alarm events to the support of recorded picture sequences.

In order to be able to use its many facilities, a certain amount of background knowledge about the logical structure and the terminology is necessary.

Views
The distribution of viewers in the program window and their arrangement is what is meant by "views". It refers to the optimum exploitation of the available area.

Scenes
Scenes are similar to views, and can be confused with them. This is not surprising, since they are indeed views, but in this case a connection to a media channel has been assigned to them. When the scene is loaded, the viewers contain pre-defined connections, and display the media channels.

Profiles
Profiles are settings that apply to a user who is logged on. You create profile using the profile manager. The settings include the way G-View will appear, along with the user's rights. Profiles can be created, edited, cloned and deleted at any time. If there is no dedicated profile for a particular user, the standard profile is loaded.
G-View - Description of the User Interface

The G-View user interface after opening the program.

The menu and toolbars are at the top 1.

The selection area where settings can be made are again at the left-hand edge 2. Here you can, for example, choose predefined Viewer with a simple click at menu Scenes (see chapter Scenes or Symbol bar).

The greatest part of the area is for the viewers, which can be arranged over the area in various ways 3. Some templates can be called up immediately just by clicking. (See under SCENES and SYMBOL BAR).

Beneath the Viewer area there are the toolbars for: Recorder control, Alarm list and Telecontrol [Remote control] 4.

**Hinweis:** Own templates for views and scenes are to be set up in the G-View Profile Manager. Detailed information about the Profilmanager you can find in G-Help.
Profile Manager

In addition to the working area, the G-View Profile Manager is also located here. It opens when the Profile manager is selected from the Options menu. The profile manager is the most important setting tool for G-View. The profile manager opens with the settings that apply to the registered Windows user. By default this is the profile of the administrator. The profile can be edited directly. Changes must be saved.

The G-View Profile Manager after opening the program

Detailed information about the profile manager and the editing of profiles you can find in the online help G-Help.
Seeing and Controlling Images

Please start **G-View** with **Double click** on the Desktop Icon.

Connect G-View to a selected server with **Click** on a **Server** in the selection area at **Video servers**.

Below the activated server (orange) all available cameras are shown.

**Linking viewers to media channels (Cameras)**

- by selecting the viewer and then double clicking the media channel or
- simply by dragging a media channel to the viewer.

**Linking of all available cameras to all available viewers at the same time:**

Right click on the activated server opens a dialog window.

Choosing „**Show cameras**“ links all available cameras to all available viewers with one click.
Select views and scenes

If the standard viewer doesn’t meet your needs, you can choose predefined templates with a simple click at the selection area under **Scenes**.

Own Templates for views and scenes are to be set up in the **G-View Profile Manager**.

Controlling the image of a media channel

The control bar is used to control the images in the active viewer. Here is a view of the control bar with timeline:

The control bar is used to control the images in the active viewer. Here is a view of the control bar with timeline

Here is an overview of all the controls:

<table>
<thead>
<tr>
<th>Default</th>
</tr>
</thead>
</table>
| Faster database rewind  
(speed adjustment using the slide controller) |
| Rewind |
| Rewind picture-by-picture |
| Stop |
| Fast-forward picture-by-picture |
| Fast forward |
| Faster database fast-forward  
(speed adjustment using the slide controller) |
| Live streaming/pictures from the database |
To the right you will find additional buttons:

- **EVENTS**
- **SECTION**
- **MOS**

With a click you can switch the right control bar from **Event** to **SECTION** or **MOS**.

Here is an overview of all the controls in this control bar:

<table>
<thead>
<tr>
<th>EVENT</th>
<th>SECTION</th>
<th>MOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start of the database</td>
<td>To section start</td>
<td>Start of the database</td>
</tr>
<tr>
<td>First event</td>
<td>Set section start</td>
<td>MOS backwards</td>
</tr>
<tr>
<td></td>
<td>Loop</td>
<td></td>
</tr>
<tr>
<td>Last event</td>
<td>Set section end</td>
<td>MOS forward</td>
</tr>
<tr>
<td>End of the database</td>
<td>To section end</td>
<td>End of the database</td>
</tr>
</tbody>
</table>

With a click you can switch the right control bar from **Event** to **SECTION** or **MOS**. Depending on the settings, the buttons described above are now available.

**Zoom**

If you have a wheel mouse, you can use the scroll wheel to zoom in/out in the digital viewer. In order to do this, click on a viewer to select it and turn the wheel:

The picture is digitally zoomed.

Additionally, using the scroll wheel you can control the speed of the pictures when scrolling through the database. To do so, click once on the bar above the control button and scroll up or down.
Working with the time line
If you have activated the time line in the View menu, an additional time line is displayed next to the control bar icons.

Use the time line to navigate quickly in the active viewer: you can move the orange range with the mouse in the set time frame (30 minutes in the illustration). The active viewer is stopped and the saved picture for the set time point is displayed.

To change the time frame, click the + and - icons within a range of 1 minute to 24 hours.

Here is an example:

A time frame of 24 hours is set. The active viewer shows the live picture from 09:39:33 am. The arrow shows the current time.

We have moved the orange range to the left in the following illustration: the help field shows the date and time (30.07.2014 04:15:19 am). The associated saved picture is shown in the viewer.

The time line enables comfortable, quick searching to the second in a pre-selected period.
# The Toolbar

The toolbar can be customised to meet your own wishes and needs. The standard settings are described here.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>Select the predefined viewer settings here: From a single image up to 36 viewers or different matrix settings.</td>
</tr>
<tr>
<td>Zoom viewer</td>
<td>If you select the zoom function and then draw a rectangle using the left mouse button, from the top left to the bottom right, the rectangle will be enlarged to the viewer dimensions. If you go in the opposite direction (from bottom right to top left), you will switch back to the normal view. This also happens when you click on the icon again.</td>
</tr>
<tr>
<td>Drag cameras between viewers</td>
<td>If the icon is marked, you can simply drag the image from one viewer to another viewer using the left mouse button.</td>
</tr>
<tr>
<td>Execute template on viewer double click</td>
<td>When the button is activated you can double click on the active viewer to activate a linked template.</td>
</tr>
<tr>
<td>Select region for Motion search MOS</td>
<td>Using the left mouse button you can draw a region for MOS (if MOS is activated without a defined area, the entire viewer is used).</td>
</tr>
<tr>
<td>Motion detection is active/inactive in selected viewer</td>
<td>Enables/disables MOS in the selected viewer.</td>
</tr>
<tr>
<td>Stretch viewer</td>
<td>Clicking on the icon stretches the viewer and fits it to the size of the GSC View window in Windows.</td>
</tr>
<tr>
<td>Letterboxing</td>
<td>The viewers are displayed in the correct aspect ratio. This may result in black bars on the edges (above/below or right/left). The text is displayed across the entire width of the viewer.</td>
</tr>
<tr>
<td>Sync or unsync all viewers</td>
<td>Synchronisation of all connected viewers with the previously selected viewer (= Master) (only G-Core OR MultiScope to be connected!). If the Master part consists of a various choices, then only the selected viewers are synchronised. If the viewers are then added/removed from the selection, these are also included or excluded from the synchronisation action.</td>
</tr>
<tr>
<td>Show event list</td>
<td>Opens the event list in its own window.</td>
</tr>
<tr>
<td>Open cut list</td>
<td>Opens the cut list.</td>
</tr>
<tr>
<td>Save pictures as GBF or MPEG</td>
<td>Opens the export dialog to save images in GBF or MPEG format.</td>
</tr>
<tr>
<td>Save picture of selected viewer</td>
<td>Saves the current image of the selected viewer as BMP, JPG.</td>
</tr>
<tr>
<td>Print picture of selected viewer</td>
<td>Opens the print export dialog to print the current viewer image.</td>
</tr>
</tbody>
</table>
The Menus

You will find five additional icons below the toolbar. Clicking on the corresponding icon opens the associated selection menu:

- **Video servers**
- **Backup files**
- **Scenes**
- **Search Filter**
- **Tools**

**Menu Video servers**

In the VIDEO SERVERS menu you connect G-Core to the selected server. In this example, G-Core is connected to the local server, and shows the first 10 media channels that can be sent to the viewers.

**Menu Backup files**

The menu *Backup files* ...

**Menu Scenes**

The SCENES menu allows you to load ready-made templates for your viewers connected to media channels with a single click.
Menu Search/Filter

The selection menu Search / Filter enables you to search pictures in the database. You can enter a date and a time or use Jump in time according to the jump in time set to page forwards and backwards.

The extended settings open dialogs for the Advanced search... [Advanced search ...], for filters and movement search in the background using MOS.

Menu Tools

The Tools selection menu provides various setting tools.

Using the Viewer Selection you define the image sequences, which you can save by clicking on the export icon or add to the cut list by clicking on the scissors. A click on the X deletes the selection in the selected viewer.

You can see the controls for the adjustment of the picture depiction (brightness, contrast and color) under Viewer Adjustment and Quality (DLS quality).

Clicking on the disk saves the settings as default.

Clicking on the icon transfers the settings to all viewers.

Clicking on the arrow loads the current settings and resets any changes to the default.
Searching and Filters

There are two types of search available under the Search/Filter menu: **Simple Search** and **Advanced Search**.

**Simple Search**

Click on the viewer that is showing the media channel whose image database you want to search through.

Clicking Date/Time opens the search function.

Enter the date and time of interest, then click Search...

When an image is found it will be displayed.

You can refine your search, in particular if you know the approximate time. To do this, use the Jump by Time function.

First enter the date and time for a search and then execute the search.

Now enter a time interval and use the two buttons to jump forward or backward by the specified interval.
Advanced Search

Clicking Advanced search opens the Search options dialog.

For all tabs: You can reset the set search criteria by simply clicking X.

Options

You can search for date/time and for events.

For our search example, we have selected Events in the search dialog. The dialog shows the Available events on the left-hand side and the Selected events on the right-hand side. To select an event for searching, highlight it, then click the arrow that points to the right.

The highlighted event appears in the list of selected events, and is removed from the list of existing (selectable) events.

To remove an event from the list of selected events, highlight it and click on the arrow that points to the left.
MotionSearch MOS

MotionSearch, abbreviated MOS, is a simple and very efficient means of quickly finding motion in recorded pictures of a media channel.

A vehicle can for instance be marked in the recorded pictures of a parking lot and MOS then searches the database for motion within the marked area. In this way, the time of arrival of the vehicle, persons in the vicinity of the vehicle and other vehicles in the marked area can quickly be identified.

The function is easy to use. There are two associated icons in the toolbar:

- Set region for MOS
- Motion detection is active/inactive in selected viewer

Background MOS
Background MOS is also possible, in which detected motions are added to a cut list.

Using MOS in the active viewer
For motion search, a rectangle can be drawn in the viewer, within which a motion search will be performed (recommended approach). If you do not specify a search area, the search will be performed in entire view area.

- Click on the Set Region for MOS icon, hold down the left mouse button and draw a rectangle.
- Click on the Motion Detection is Active/Inactive in Selected Viewer icon. This activates or deactivates the search in the current viewer.
Manual search
With this type of MOS you jump from one motion to the next. Every search process must be started with a click. This is how manual search is started:

- For a reverse search, click on the adjacent icon. The search is started. The picture stops when the first motion in the marked area is detected. Time and date can be seen in the viewer. By clicking on the icon again, the search is continued.
- By clicking on the adjacent icon, the search direction is changed to real time.

Automatic search
If you want to perform an automatic search of all motion within an area, then use Background MOS.

Using Background search
Background MOS can be started on a viewer. All detected entries during a search are entered into the cut list. A new cut list is created for every background search.

Background MOS can be started on a viewer. All detected entries during a search are entered into the cut list. A new cut list is created for every background search.

Enter date and time period for the selected search.
Then open *Advanced Options* or click on *OK* to start the search.

The previously drawn rectangle of the viewer is used for the Background MOS. If no rectangle has been defined, the entire viewing area is used. Background MOS is performed for the specified period of time.

**Additional options are:**

<table>
<thead>
<tr>
<th><strong>Min. motion duration</strong> in milliseconds</th>
<th>This is where you specify how long a motion must last in order to be detected as a motion.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add time before motion</strong> in milliseconds</td>
<td>If a motion was detected, the time interval can be increased forwards and backwards. If two successive motions overlap, they can be combined into a single entry.</td>
</tr>
<tr>
<td><strong>Add time after motion</strong> in milliseconds</td>
<td></td>
</tr>
</tbody>
</table>

Sometimes more information about the detected motions is needed. For instance, you have detected a motion by a person in a workshop. You would now like to know, where the person came from and where the person went (corridor cameras).

Mark the relevant entry in the cut list (multiple marking is possible) and drag the relevant media channels to the marking. The media channels are added to the MOS entry for the same period of time.
Export / Backup

Exporting Pictures

In GSCView there are three options for exporting individual pictures:

- Saving a picture as BMP, JPEG or RAW
- Printing an image
- Copying to the clipboard

Saving a picture as BMP, JPEG or RAW

To save a picture from a Viewer as BMP, JPEG or in RAW format, in the menu File click on Export picture as... or right-click on the viewer, then in the context menu on Export and then on Export picture as....

The format can now be selected using the selection dialog for the file names:

- BMP
- JPEG (low, medium or high quality]
- RAW
RAW

If RAW is selected, the picture is saved in a file, unchanged. For viewer displays under the JPEG Function packet and for IP cameras, a JPEG file is easily created.

BMP / JPEG

For the other formats, an options dialogue is now opened:

Options are:

- Texts that should be included on the picture (where applicable).
- Font and font size of the text
- Position of the text
Text

<table>
<thead>
<tr>
<th>Date / Time</th>
<th>Date and time of the saved pictures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel description</td>
<td>Naming of the channel</td>
</tr>
<tr>
<td>Alarm text</td>
<td>Alarm text (where applicable)</td>
</tr>
<tr>
<td>Event name</td>
<td>Event names (where applicable)</td>
</tr>
<tr>
<td>Event description</td>
<td>Event description (where applicable)</td>
</tr>
<tr>
<td>Event parameter</td>
<td>Event parameter (where applicable)</td>
</tr>
</tbody>
</table>

Text alignment

<table>
<thead>
<tr>
<th>Top</th>
<th>Left</th>
<th>Defines where the text will appear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom</td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>Right</td>
<td></td>
</tr>
</tbody>
</table>

If the option *Only show this dialog when Shift key is down* has been set, then this dialog is skipped and the last chosen options are used.
The dialogue is only shown again if the Shift key is held down on calling up ‘Export’, or when the menu option *View -> Export -> Show Export options* is chosen again.
Opening the option dialogue can also be suppressed if the user chooses the right-click menu *Export -> Show Export Options*.
The font and font-size are determined with a click on the switch *Change*.
Confirm your choice by clicking on ‘OK’.
The settings can be verified immediately via a simple preview.

The ExportPrivacy function can be used in this preview image.
More information can be found under ExportPrivacy in G-Help.

Otherwise the picture is saved by clicking OK.
Printing an image

The printing of an image can be managed via the menu File -> Print picture ... or via the viewer context menu Export -> Print picture....

First the ExportPrivacy dialog opens:

The ExportPrivacy function can be used in this preview image. More information can be found under ExportPrivacy in the online help G-Help. Otherwise, the Options dialog for printing will be opened by clicking on OK:

- Texts (where applicable) to be shown under the picture.
- Editing of the page
- Edit page
- Print preview
The settings can be verified immediately via a simple preview. The options are saved and are preset for the next export. Clicking on Print preview, the following preview dialogue opens:

If the option Only show this dialog when Shift key is down has been set, then this dialog is skipped and the last chosen options are used.

The dialogue is only shown again if the Shift key is held down on calling up ‘Export’, or when the menu option View -> Export -> Show Export options is chosen again.

Opening the option dialogue can also be suppressed if the user chooses the right-click menu Export -> Show Print Options.

**Edit page**

With **Edit page**, the page can be edited before printing.

Here, texts can be added or cleared. In addition, the font, the font size, color and alignment can be changed. Additional pictures can also be added.

On leaving the editor, after an enquiry the changes are applied.

**Export to clipboard**

You can also copy the viewer picture for editing, for example, via the menu File -> Snapshot to clipboard, or via the viewer context menu Export -> Snapshot to clipboard.

The picture is then copied to the clipboard without showing text and can be saved in other applications as a Bitmap from there.

If the Shift key is pressed in during the menu selection, the operations dialog for picture export is opened. There the same options can be selected as for single picture export in a file.
Backup

Select region to be backed up

The first step in backing up a sequence of images is to specify the start and end of the sequence.
Open the **Viewer Selection** section under the Tools menu of G-View.
Click to select a viewer, and use the play buttons to move to the start of the sequence of images that you want to record. Then click on **Set Beginning of Selection**.
Deal with the end of the desired sequence of images in the same way.
In this case, click **Set End of Selection**.
You have now specified the sequence of images that is to be saved.

Saving the Backup

We will show you how the backup of a chosen sequence of images is saved with the aid of an example.

A selection has already been made in the marked viewer. You use the two buttons to specify how you want to continue:

- Save selected region
- Cancel selection
In our example, we have clicked the symbol of the disc in order to carry out the backup. A few other information items are now required, and these can be provided in the dialog box that opens.

First specify the format. A choice is available between the G-Core Backup Format (GBF) and MPEG. The MPEG export format is intended for the export of short film sequences. MPEG-2 can be used in combination with Windows Media Player.

Microsoft does not provide a MPEG-2 decoder because of licensing issues. DVD player software must be installed in order to enable replay of MPEG-2 videos.

The in-house GBF format is superior to MPEG-2 in the following aspects:

- Export speed
- Multi-channel export and synchronized replay
- Event data can be exported and used as search criteria

Select Current selection as Range.
Select range presents the option of selecting a new range. Complete selects all saved pictures of the selected channel.
The channel is selected under Media channels.
Since date and time have already been set, no additional input is required here. If you want to make any changes, please do it here.

Now you need to specify how large the MPEG file may grow before it must be split. If *No limit* is selected, a very large file could be saved on the hard disk in the next step, which then could not be copied to a medium to be passed on. Therefore the options of DVD (4,300 MB), CD (640 MB) and *Customized* are offered.

**Encryption**

If the backup is performed as GBF, you can specify that a viewer must also be saved. In case of high security requirements, the backup can be encrypted with the selection of an encryption key of up to 128 characters. This is not just password protection, which could possibly be hacked quite easily, but a genuine full encryption of the file.

If you want to open the saved file again, you must provide the key. **Warning:** If you forget or lose the key, the file cannot be deciphered again.

If you have selected MPEG as format for the backup, you can select the degree of compression of the MPEG file in *Advanced options*. The higher the level of quality is, the larger the backup will be.

Click **OK** when you have made your choice.

The dialog box where the storage location is selected now opens. Select the desired hard disk and, if appropriate, additionally choose a directory.

Then click **OK**. The backup procedure starts.
When the backup is complete, you receive a message, in which you can again see the storage location and the filename. The filename is composed of the channel number, the channel name, the date and time of the selection.

If you acknowledge the successful backup by clicking OK, the process is then complete.

**Export comment**

You also have the option of saving a comment together with the video sequences. This comment can later be displayed via G-View => File => Show export information.

Open the Export comment tab in order to save a comment.
Backup on DVD

All formats generated during the export can be burned directly to CD or DVD if you activate the option *directly write to CD/DVD*:

- Backup files (gbf, mbf)
- Recoding MPEG export (mpg with/without audio, mp4)
- MPEG4CCTV (m2v)
- VideoDVD (with/without Audio).

The export and downstream processing are split into separate steps that are executed in parallel. The available burner is selected at the start of the export. This can also be the ISO Writer.
Canceling the export
The export can be interrupted at any time. If this is done, you will be asked if you wish to also cancel the burning procedure. You have the following options:

<table>
<thead>
<tr>
<th>Yes</th>
<th>Cancel all</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>End the current burning procedure and delete the pending jobs</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel the cancel command and continue</td>
</tr>
<tr>
<td>Complete all pending burning procedures</td>
<td>(only displayed when multiple jobs are pending)</td>
</tr>
</tbody>
</table>

Status window
The individual operations (generation of the ISO file and the actual burn procedure) are listed in the status window. Both have their own status bar and indicate the current medium:

Once a burning procedure has been completed, the user may be prompted to insert a new medium. Only media with sufficient space will be accepted. The additional burning procedures can also be canceled.
The successful completion of burning will be shown.
Advanced Options

The option *Max. file size of backup file* cancels the export when the specified size has been reached.
With the option *Split files with max. file size*, the export is split into individual files with the specified size.
During the DVD export, these individual files are created as separate chapters.

In some situations, the export files are divided automatically.
- Files can only be burnt up to a size of 4 GB.
- For an MPEG export with audio, the files have a maximum size of 2 GB.
- For export of a cutlist, during the MPEG/VideoDVD export, a new file is started for every transition between audio/no audio or vice versa.

With the option *Include viewer in backup*, G-View is also burned onto each CD/DVD during the gbf/mbf export.

The DVD Writer can only be used by one export. As long as the burner is in use, no new export with burning can be started. It is also not possible to burn in parallel on multiple burners.

USB Memorystick

Export to a USB memory stick is interrupted when the stick is full, and the user is then prompted to insert an additional memory stick.
Lists

Eventlist

By clicking on the icon in the toolbar, the Event List opens. The list is opened in a separate window.

The server selection shows the server for which the events are displayed. When you click on another server, its events are displayed. The media channel to be displayed is selected in the same way. If no events exist on a server or in a selected media channel, you receive a corresponding message.

Existing events are shown in great detail in the overview with time and date, event name, stop time and the configured text. When you open an event, you are also shown all further information about the event.
The alarms are also shown in the list. They are indicated with a different symbol.

**Filter events**

The event filter dialog offers a number of options of filtering the events list according to specific criteria in the search for certain events:

<table>
<thead>
<tr>
<th>Filter events</th>
<th>Date/time</th>
<th>Filter according to date and time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Media channels</td>
<td>Filter according to media channels</td>
</tr>
<tr>
<td></td>
<td>Event types</td>
<td>Filter according to event types</td>
</tr>
<tr>
<td></td>
<td>Data filter</td>
<td>Filter according to data types</td>
</tr>
<tr>
<td></td>
<td>Advanced</td>
<td>Opens the standard filter dialog</td>
</tr>
<tr>
<td></td>
<td>Clear Filter</td>
<td>Delete filter</td>
</tr>
<tr>
<td></td>
<td>Apply filter</td>
<td>Add a filter</td>
</tr>
<tr>
<td></td>
<td>Activate filter</td>
<td>Activate or de-activate a filter</td>
</tr>
</tbody>
</table>

It applies to all filters, that they are only activated if you have clicked on the *Activate filter* button.
Data filter

The Data Filter allows very intensive filtering.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not used</td>
<td>The data filter is not being used</td>
</tr>
<tr>
<td>Cash management</td>
<td>Opens the dialog for cash management</td>
</tr>
<tr>
<td>G-Core action filter</td>
<td>Opens the dialog for actions</td>
</tr>
<tr>
<td>ATM transactions</td>
<td>Opens a dialog for ATM search items</td>
</tr>
<tr>
<td>G-Core generic</td>
<td>GSC-specific items</td>
</tr>
<tr>
<td>Number plate recognition</td>
<td>Opens dialog for number plate recognition</td>
</tr>
<tr>
<td>Point of sales</td>
<td>Opens dialog for point of sales</td>
</tr>
<tr>
<td>SCS data filter [Supply Chain Security]</td>
<td>Opens the dialog for Supply Chain Security events</td>
</tr>
<tr>
<td>Barcodes</td>
<td>Opens the dialog for bar codes</td>
</tr>
</tbody>
</table>

Advanced

The Filter dialog opens, which guides you through the search function (the search corresponds to the familiar search in G-View).

Event Count

Specification of the number of displayed events allows you to access the data more quickly, in some cases speeding up the search significantly. By default the event count is set to automatic. If we assume that your application was created using the SDK, and you can expect an exact number of events, then you should enter this number here. This will greatly speed up the process of finding specific events.
Alarm list

You open the alarm list by clicking the icon underneath the viewer. The empty list displays three columns.

When the system triggers an alarm, it is not just the alarm dialog that opens, but an entry is also made in the alarm list.

The alarm is displayed in the colour appropriate to its priority, along with its start time and the configured alarm text. If no text has been configured, only the initiating event is listed. A configured alarm description appears in front of the triggering event, while a triggered event text appears behind the triggering event. In our example, both of these messages are represented by a * as a place holder.

Double clicking the alarm opens the relevant media channel in the standard view or in the defined alarm scene.

As long as you have not confirmed an alarm, you cannot switch to a media channel or change the scene.

You can select a listed alarm by clicking it, you can confirm it by clicking the Confirm button, or you can remove it from the list of by clicking Remove.
Cut list

The Cut list provides an easy way of creating sections from a database, to edit them, to display them and to export them.

This Cut list consists of individual entries with begin and end times and a camera list. Each entry has got a name and a comment.

The position of the entries in the list and the cameras can be moved, which has got an influence on the replay and the export.

An entry can only contain cameras of a single server. However, a Cut list can contain entries from different servers, which could be G-Cores, reporter or MultiScopes. Up to 10 Cut lists can be edited simultaneously.
The Cut list dialog user interface

The Cut list dialog comprises four parts:

1. **Menu and toolbar**
2. **Selection menu**
3. **The actual Cut list**
4. **Viewer with time line and control**

### Menu and toolbar

<table>
<thead>
<tr>
<th><strong>File [Datei]</strong></th>
<th><strong>Export images</strong></th>
<th>Export the Cut list as a gcl (G-Core cut list) or as a merged MPEG or video DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Export images</strong></td>
<td><strong>Import cut-list</strong></td>
<td>Opening a gcl file. The associated files can be loaded into the entry via the drop-down menu</td>
</tr>
</tbody>
</table>
### Edit

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New list</td>
<td>Create a new list</td>
</tr>
<tr>
<td>Delete List</td>
<td>Delete the entire list</td>
</tr>
<tr>
<td>New entry</td>
<td>Create a new entry</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy an entry (multiple selection is possible)</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste a copied entry</td>
</tr>
<tr>
<td>Merge</td>
<td>Merge entries (multiple selection is possible). Entries originating from the same server are merged, i.e. the earliest begin time and the latest end time is used to create a common camera list</td>
</tr>
<tr>
<td>Move up</td>
<td>Move entry or camera up</td>
</tr>
<tr>
<td>Move down</td>
<td>Move entry or camera down</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete an entry or a camera (multiple selection is possible)</td>
</tr>
</tbody>
</table>

### View

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide/show Viewer</td>
<td>Hide or show the panel with the current viewer. This setting also influences the display of the Cut list</td>
</tr>
<tr>
<td><strong>Hide viewer</strong></td>
<td></td>
</tr>
</tbody>
</table>
Selection menu

The selection menu has got three fields: Cut list, Server and File.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut list</td>
<td>All Cut lists, which are currently being edited, are shown in this field. The work list is always present and cannot be deleted. New entries are always added to the selected list. For Background MOS separate lists are created to which entries are added, irrespective of whether they are selected or not.</td>
</tr>
<tr>
<td>Server</td>
<td>A list of all connected servers and their cameras. The cameras can be dragged onto individual entries and are then added there if the entry belongs to this server.</td>
</tr>
<tr>
<td>File</td>
<td>Import and export options are available here.</td>
</tr>
</tbody>
</table>

The Cut list

The actual Cut list is situated in the center, structured as a table. There are four columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry</td>
<td>Shows the camera and the server. When the entry is opened, the associated media channel is displayed.</td>
</tr>
<tr>
<td>Begin</td>
<td>Date and start time of the entry</td>
</tr>
<tr>
<td>End</td>
<td>Date and end time of the entry</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments on the entries can be made here</td>
</tr>
</tbody>
</table>

Viewer with time line

On the right hand side there is a viewer with a time line for displaying cameras and for navigating. The two buttons (directly above the viewer) can be used to switch between Zoom mode and Drag mode. Below the current viewer there are buttons for displaying the Cut list, for changing times of the entries or for closing the dialog.

Working with the Cut list

Opening the dialog

There are various options for opening the Cut list dialog:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>In the View or Viewer menus, click on the Cut list entry in order to open the Cut list dialog.</td>
</tr>
<tr>
<td>Symbol bar</td>
<td>![Icon] Click on the icon to open the Cut list dialog.</td>
</tr>
<tr>
<td>Context menu of the Viewer (Right mouse click into the viewer)</td>
<td>In the drop-down menu, click on the Cut list entry in order to open the Cut list dialog.</td>
</tr>
</tbody>
</table>
**Adding entries**

New entries which are created directly in the Cut list dialog always have the current time as begin time and an end time of 5 seconds later. The first column of the entry contains the index and the name of the server. After that the name of the entry follows. The next two columns contain the begin time and the end time and the last column contains a comment.

Entries can be added in a number of ways:

<table>
<thead>
<tr>
<th>In the Edit menu</th>
<th>Click on New entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Cut list</td>
<td>Right-click on the Cut list and select New entry in the drop-down menu.</td>
</tr>
<tr>
<td>By using the Server list</td>
<td>Drag a camera directly from the Server list into the Cut list. This creates a new entry with the current time of the viewer.</td>
</tr>
<tr>
<td>By using the current viewer</td>
<td>If the current viewer is in Drag mode, a camera can be dragged into the Cut list from this viewer.</td>
</tr>
<tr>
<td>By using the selection menu Viewer selection</td>
<td>By clicking on the Cut list icon in the selection menu Viewer selection, an entry with the beginning and end time is created from the selection.</td>
</tr>
<tr>
<td>By using the Event list</td>
<td>Right-click on the event and then on Add to Cut list in the drop-down menu. The beginning and end times and the camera list are taken over.</td>
</tr>
</tbody>
</table>

**Editing entries**

All entries can be edited by means of a slow double-click or by pressing the F2 key. Camera names, however, cannot be edited.

The drop-down menu, which is opened with a right-click, can be used to switch between date and time.

By double-clicking on the entry Show image the camera is either displayed in the current viewer or in the selected viewer of the main window.

Navigation is then possible in the current viewer and the displayed point in time for the selected Cut list entry can be specified with "As begin time" and "As end time".
**Change sequence**
The sequence of entries can be changed. The selected entry can be moved up or down with the arrows on the toolbar or by means of dragging with the mouse. The sequence of cameras of a Cut list entry can be changed in the same way.

**Merging entries**
Entries can also be merged. Either via the drop-down menu, the toolbar or by dragging with the mouse. Merging is only possible if all entries originate from the same server. The earliest begin time and the latest end time is taken and the camera list contains all cameras and all entries.

**Duplicating entries**
Entries can be duplicated or transferred to other Cut lists by means of copy and paste. Furthermore entries can be deleted or entire lists can be cleared. The Cut list can be replayed as a whole, by clicking on the Play forward button or Play backward button. If the current viewer is displayed, all cameras are shown in succession. If the current viewer is not displayed, individual cuts are replayed in the main window. If a cut contains multiple cameras, a scene which can display all cameras is automatically selected. Replay is then synchronized.

**Import and replay**
A Cut list can be imported into the main window for replay and into the Cut list dialog for further editing. If a gcl (Geutebrück Cut LIST) file is opened in the main window, a new entry for the Cut list and a list of all individual cuts is created in the directory tree. Replay of the Cut list can be started with a double-click on the entries. All cameras of a cut are replayed synchronously. Replay mode can be changed via the toolbar (forward, reverse, fast, slow, individual picture). Associated backup files can be displayed via the drop-down menu of the Cut list entry. Contained cameras can be activated as for other export files. If a Cut list is opened in the Cut list dialog, only the Cut list and the entries are displayed initially. If pictures are to be displayed, the associated backup files must be loaded. (Via the drop-down menu -> Load backup files). The Cut list can then be edited and expanded.
Export options

The Cut list can be exported via the selection menu File - Export images.

Export dialog

The dialog starts with a query about the way in which the Cut list is to be exported.

The following two formats are available for exporting:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG</td>
<td>For a MPEG export all entries and all cameras are exported sequentially as a film. The sequence of entries and cameras can therefore be changed.</td>
</tr>
<tr>
<td></td>
<td>Text masking can be activated. The name and comment of an entry can be masked in addition to the MPEG export.</td>
</tr>
<tr>
<td>CutList (gcl)</td>
<td>A backup file and an additional description file (gcl) are created for each involved server in case of an export as a gcl file.</td>
</tr>
<tr>
<td></td>
<td>Export files can be opened via the gcl file, either individually or as a Cut list.</td>
</tr>
</tbody>
</table>

**ADVICE** Export as a raw MPEG is not possible, however, a video DVD can be burned directly.

Advanced options

Advanced options can be used to:
- set maximum file size and possibly file splitting as file options,
- set bandwidth, encryption and the option of adding a viewer to the backup, as backup options.

Export comment

Some comments regarding the export, content, etc. can be made on the Export tab.